
VLBI OPERATIONS 
SYNCRONIZED 
SWIMMING IN 

DIFFERENT POOLS 



RDBE RAW Capture Mode:  Provides ability to see the incoming signal from the iADC before it is processed by the FPGA personality.  This can be 
incorporated in the FSPC software as a snap command with “client=mon” feature. 

 

TOW 2015 Notebook, RDBE Setup and Operations, Chet Ruszczyk, slides 27-28 
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TOW 2025 
VLBI Session Pre-Checks 

For VGOS Systems Class Discussions 
Alex Burns,  aburns6@mit.edu 

Chris Coughlin, ccough01@peraton.com 
 
 
 

1. Walking into your VGOS/VLBI site 

a. What do you see, hear, or smell? 

2. Experiment SNAP and procedure files 
 

a. We must retrieve and create the .snp and .prc files for your session 
i.  fesh <schedulename> -d 

ii. feshp -d <schedulename> (prints snap summary and session notes) 
b. Legacy: 

i. Retrieve your .skd file from CDDIS 
ii. Drudg <sessionname>.skd 

1. Create the SNAP and procedure file.  
2. Print hardcopies of the schedule and session notes. 

iii. Edit the session procedure file to insert station-specific parameters such as 
IF distributor attenuator settings needed for your station. 

iv. Be sure to create a new procedure file for each session from the .skd or 
.drg file.  

1. Do not use default set-up procedures in the station procedure file  
 

3. Computer control 
a. Start the FS by issuing the following command: 

i. fsclient    This should bring up the standard operational windows 
b. Check that the FS is controlling the VLBI terminal and antenna. Some stations 

have multiple operational control systems. 
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4. Station timing 
a. All station clocks should be identified and confirmed synced within spec prior to 

any VLBI session. 
b. PCFS CPU (2 weeks) 
c. PCFS (correct second) 
d. ACU (Antenna) (Correct second) 
e. GPS ( Offset from station equipment <50 us) 
f. R2DBE (4) (correct second) 
g. R2DBE epoch (4) (time from last sync?) 
h. Mark6 (correct second) 
i. NTP  
j. GPS 1 PPS Offset 

i. Using a counter with time interval measurement accuracy <100 ns, 
measure the time interval between the 1pps signals from: 

1. R2DBE and GPS receiver 
2. Maser and GPS receiver. 

ii. This offset should be within a few microseconds of each other. This 
number should be monitored as it could be the first indication of a 
possible system failure. 

 

5. Feed polarization 
a. Some stations may have multiple receivers and configurations. Before each 

session you should make sure that the feed polarization is correct. 
i. For geodetic S/X observations, the correct polarization is RCP. 

ii. For VGOS use linear X (H) and Y (V). 
 

6. Receiver 
a. Confirm Your receiver choice is VGOS and all receiver cable connections are 

correct 
b. Check that the physical temperatures of the 20 K and 70 K stations in the Dewar 

are within their normal ranges and are not rising. 
c. Check that other receiver parameters (helium pressure, voltages, currents) that are 

monitored are within their normal ranges. 
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7. RF distributor 
a. Confirm output cables are connected to the correct UDC inputs 

 
 

8. Antenna focus 
a. Some antenna sites have moveable feed positions. 

i.  For VLBI observations, the focus should be stationary in its correct 
position.  

9. Antenna pointing 
a. Check antenna pointing: 

i. If possible using two or more widely-separated sources. 
ii. Position the antenna on a source 

iii. fivept     this will generate the offset numbers 
b. Pointing errors in both axes should be smaller than beamwidth/10 at the highest 

observation frequency. 

10. System Equivalent Flux Density (SEFD) 
a. Once you confirm your pointing offsets. Have the system generate your SEFD 

numbers 
b.  onoff          This measures the SEFD in each frequency band and polarization and 

the station compares against the nominal historic value.  Some sites are measuring 
all channels not just the standard 8-channels from the typical on-off. 

c. ONOFF should be run after you open the log file for the session you are about to 
start 

i. Using a strong radio source of known flux density, measure Tsource/Tsys. 

ii. Convert to SEFD by dividing Tsource/Tsys into the source flux density 
(corrected for size effect if the source angular extent is comparable to, or 
larger than, the antenna beamwidth). 
 

11.    System temperatures 
a. With the antenna pointed near zenith (clear sky), measure the system 

temperatures in all broadband channels, and compare against nominal values. 

12.    Phase calibration signal 
a. Confirm your PCAL levels are correct on your PCFS monitor window or using a 
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spectrum analyzer. 
 
 

13.    Cable calibration 
a. The cable counter should be operating in single–sample mode, not averaging. 
b. The cable counter reading should be in the normal range. 
c. Single–sample readings should be stable to ±1 μsec. 
d. Check that the cable calibration system measures cable length changes correctly. 

1. cable       this puts the cable reading into the log 
ii. Insert a short cable length in the cable from the ground unit to the 

antenna unit, and log the cable reading using the following command: 
1.  cablelong  

iii. Remove the short cable and log the cable reading again 
1. cable 

iv. Compare the change in readings with the nominal value. 

1. cablediff  
 
 

14.    Mark 6 Recording systems 
a. 8-Pack module Installation – 
b. Remove the 8-pack from the shipping box and anti-static bag. 
c. Inspect for damage. 
d. Pull front lever down so that it is horizontal. 
e. Slide 8-pack easily into Mark6 machine until it stops. 
f. Lift front lever which will insert the 8-pack into the connector. DO NOT PUSH 
g. Insert the data cables into the correct connectors on the front of the module 
h. Turn the key switch to the right until it stops. 
i. The module lights will blink in a specific order and pattern 

i. Recognize this and confirm all lights indicate correctly 
ii. This may be you first detection of a module problem 

j. Individually repeat this for multiple modules if requires for the session 
 
 

15.    Conditioning the modules 
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a. If there is time each 8-pack that is received at a station should be conditioned 
before it is used to verify there has been no shipping damage. This can be done in 
any appropriate lengthy gap in operations. With the larger modules it may take 
multiple days to condition. These larger modules should be done over the weekend 
if possible when there are no operational sessions. Please see attached 
conditioning memo.  

 
 

16.    Meteorological sensors 
a. Check that the values of barometric pressure, temperature, and relative humidity 

reported by the ‘wx’ command are reasonable and repeatable. 
 
 

17.    More extensive testing 
a. After any equipment, software changes or if a long period of time has elapsed 

since the last VLBI session, more extensive testing of the VLBI systems should 
be carried out. More rigorous testing should also be conducted on a periodic basis 
(monthly to annually). Such tests could include: 

i. Measure pointing offsets over the full sky.  
ii. Check for RFI and for jumps in the phase cal phase and cable cal as the 

antenna is slewed across the sky. 
iii. Measure the DC level and AC ripple in the any system or equipment 

power supplies. 
iv. Clean all equipment filters and cooling fan port 

 

18.   Begin Pre/Ops Checklist 
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IVS Operations workshop TOW 2025 
 

1. Starting a schedule 
 

a. The basic steps in starting a schedule are: 
 

b. Reporting problems when you need urgent help. 
 

c. An e-mail list has been set up for items needing urgent attention by 
the IVS Coordinating Center.  

                          The address is: ivs-urgent@lists.nasa.gov 
 

d. This list should be used by anyone needing urgent attention by or advice 
from the Coordinating Center. You can expect an answer normally within a 
few hours, if the message is sent during US East Coast working hours. 
Messages sent on weekends or after hours may take a little longer. 

 
e. Please use this address rather than sending messages to ivs-

ops@lists.nasa.gov  or ivs-stations@lists.nasa.gov . If the reply from the 
Coordinating Center is of interest to a broader audience, we will copy the 
appropriate lists on the response. 

 
f. Anyone can post a message to this list. The only recipients for this list are the 

Coordinating Center staff: Dirk Behrend, Ed Himwich, Cynthia Thomas, Mario Bérubé, 

mailto:ivs-urgent@lists.nasa.gov
mailto:ivs-ops@lists.nasa.gov
mailto:ivs-ops@lists.nasa.gov
mailto:ivs-stations@lists.nasa.gov
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and John Gipson. 
 

g. Examples of the types of messages that should be sent to this list are: 
problems with schedules, problems running drudg or the Field System, 
schedules that seem to be made for the wrong date, schedules that do not 
include the right stations, operational problems during observing, and any 
urgent issue that impacts operations and you need advice on how to handle. 

 
2.    Review session notes 

 
a. This provides one last opportunity to verify that nothing special has been 

missed in the set-up for this experiment. 
 
 

3.    Start schedule 
 

a. Confirm the antenna source is in the correct wrap zone for your antenna 
b. The preferred form of the "schedule" command uses the line number to 

start with, e.g., "schedule=na225gc,#1", to start at line 1.  
 
 

4.    Send the Ready message.  
a. rdbemsg      this will send the information in a standard format and is 

recommended by the IVS 
 

b. This message summaries your status and lets the world know you are ready. 
It should be sent to ivs-ops@lists.nasa.gov. Be sure to include the session 
name in the subject line. Please include the following information. 

 
i. Comments about anything that may affect the data quality. 

If you have more than one polarization available it is 
recommended that you check the polarization to make sure 
it is correct and note that it has be checked. 

 
ii. The source and start time for the first scan. This assists the 

coordinator center in determining if you have the right 
schedule if an update was issued. 

 
iii. R2DBE to GPS clock offset. This is needed by the 

correlator to find fringes. If the backend 1 PPS starts the 
measurement please report this as the RDBE to GPS offset; 
if GPS 1 PPS starts, please report it as the GPS to RDBE 
offset. 

 
iv. WX: temperature, pressure, humidity, and sky conditions. This 

assists the analysts in understanding the atmospheric 

mailto:ivs-ops@lists.nasa.gov.
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conditions and interpreting the SEFD and Tsys data. 
 

v. Cable difference. Please report whether a longer cable 
makes the reading larger or smaller. Please also report 
the difference you observed in the reading when you 
lengthened the cable and whether it was nominal (as 
expected) or not. 

 
vi. Pointing values: Please report both band and polarization 

SEFDs, source used for measurement, its azimuth and 
elevation when measured, and the pointing offsets on 
each axis. You can include as many sources as you think 
are useful. 

 
vii. Tsys values. Please report the system temperature all bands 

and polarizations.  
 

5.     Send the Start message 
 

a. This lets the world know that you started and whether there are any 
problems. Any additional useful information for the record doesn't hurt 
either. The message should be sent to ivs-ops@lists.nasa.gov  via your 
automated system.  If this is not functioning an email to the correct address 
including all of the data can be sent. 

 
 
 

6. Making comments in the log 
a. Making comments in the log when problems occur is one of the most important 

functions of an operator. It is the primary way of information about problems to 
get to the correlators. Please provide as full a description of a problem and its 
consequences as possible. Many of the data analysts are not familiar with the 
acquisition hardware.  

b. It is important to describe the problem even if not fully understood at the time of 
detection. If the problem is resolved a full description and solution should be 
entered into the log. 

c. In this time of more remote and un-attended operations all local information 
regarding function entered into the session log is critical.  

 
 
 
 

7. Periodic monitoring, I: each scan is correct: 
 

a. For each scan the following information should be verified: 
 

mailto:ivs-ops@lists.nasa.gov%20%20via%20your%20semi-automated%20system
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i. source 
 

ii. equipment status, scan-check, system errors? 
 

iii. on-source 
 

8. Periodic Monitoring II 
 

a. These items need to be checked less frequently than every scan. Every 
hour is a reasonable interval. 

 
b. Sky conditions entered as comments 

in log Cloud cover, wind, 

precipitation, etc. 

 
c. Disk pack full? 

 
d. Check mk6=mstat?all output to see whether a disk pack has filled up and if 

so, swap it out with a fresh one. The disk pack that is not being recorded 
should always be a fresh one and a full disk pack should always be swapped 
out as soon as possible. This applies even if the one currently being recorded 
“should” be the last. 

 
 

 
 

9. System failures 
 

a. This may include failure of the main site power, Antenna system, Receiver, 
Cryogenics, R2DBE, UDC, Mark6, Disk Modules, networks, and power 
supplies,  

b. All impact data collection and analysis. The decision to continue observing 
or stop and repair the system depends on the nature of the failure. Is the data 
degraded, or missing? 

 
 

 
10. Post experiment 

 
a. The post-experiment checks provide an opportunity to "close-the-loop" on the 
      pre-experiment checks and verify that some things that cannot be checked   
      during the experiment, such as the SEFDs, are still okay. 
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b. Check cable calibration 

 
c. This verifies that the cable system still detects the calibrated cable correctly 

and hence has not failed during the experiment.  
 

d. Complete end check-list 
 

e. There are several other items on the end of experiment check-list. This 
should all be completed. The results of some of the tests will go in the End 
Message.  

 
f. Send the Stop Message 

 
i. The End Message lets the world know you have completed the 

experiment and your status at the end. This is especially useful for the 
correlator since it will help them prepare for correlating the data. This 
information should all be reported in comments in the log as well. It 
should be sent to ivs-ops@lists.nasa.gov. Be sure to include the 
session name in the subject line. The End Message should have the 
following components: 

 
ii. Scans missed 

 
iii. List the scans missed, not by line numbers, but by the time 

spans that data was lost for. 
iv. Comments 

 
v. Please describe any unusual conditions that affected data 

collection. Please describe any equipment problems. This 
might not be limited to things that affected the data 
collection, but also include items that require maintenance. 

vi. Please include any other information that you think might 
be useful for the correlator or the data analysts. 

 
vii. Stop time 

1. Indicate the time data collection stopped. 
 

viii. Clock offset information 
 

1. Report the final clock offset information. Use the same 
format as described above for the Ready message. 
Reporting the clock offset a second time may seem 
redundant but it has two purposes. First in case there was 
an error in reporting the first value, it provides a back-up. 
Secondly if there was no error in the first value it can be 

mailto:ivs-ops@lists.nasa.gov.
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used to a rough estimate of the clock drift rate. Please also 
include any information about clock jumps and the time 
span of data affected by any jumps. 

 
ix. Disk Pack 

 
x. Report the module inventory in the ‘End” message. 

 
g. Close log 

 
h. As with the pre-experiment tests, the post-experiment tests should be done 

as much as possible in the experiment log. Once the post-experiment tests 
have been completed, you can close the log, either using the "schedule=…" 
command with a null or non-existent schedule, by changing the log file 
with a "log=station" command, or by terminating the FS. 

 
 

i. Send Log   (plog -l) That is a lowercase L 
 
 

ii. Additional Module Shipping Information 
 

i. If you have any additional information about the shipping such as the routing, 
this would be a good place to send it. 

 
 

11.  Additional Experiments Comments 
 

a. If you have become aware of any additional problems or if there is any 
special information you either have discovered since the experiment 
ended or forgot to place in the Stop message, this is a good place to 
send it. You can of course send follow-up information as often as 
necessary. 

 

12. Running "logpl" 
 

a. This section describes the basics of running "logpl", a graphically oriented 
program for plotting data from the log. This program is a more modern 
version of the old "logex" program (which is still available). Please refer to the 
"logpl" manual available in PostScript form on the FS servers in the doc sub-
directory. 

 
b.  Interactive Use 

 
c. "logpl" can be started from a shell prompt by just entering "logpl". The 

program uses the X display, so the starting used must have access rights to 
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the X display. If you are using X server and open new window (C-S-W) and 
type "logpl" at the prompt, it should start okay. 

 
d. Selecting a log file 

 
e. If the FS is running, the log that is open will be selected automatically. If 

the FS isn't running or if you want to use a different log, use the "File" menu 
item and select the "New Log File" option. Enter the name of the log file 
you wish to examine. The directory will default to "/usr2/log" and the 
extension to ".log". 

 
f. Plotting Data 

 
g. You can plot up to four "channels" of data simultaneously. The menu items 

"Channel1", "Channel2", and so on are pull-down menus that let you select 
the data to be plotted for each channel. The "Options" menu item allows you 
select whether the plot are superimposed or shown separately and whether to 
connect the points with a line. 

 
 
 
 

h. Entering New Parameters 
i. You can enter new parameters to plot either by updating the logpl.ctl" 

control file and restarting "logpl" or by interactively using the 
"Options" menu item and selecting "Edit Selections" options. Any 
changes that are made interactively are not preserved when "logpl" is 
terminated. 

 
i. Printing Plots 

 
j. Once you have a plot you would like to print, you can print it as PostScript 

either to a printer or to a file. Use the "File" menu item and select the "Print" 
option to print the file. 

 
k. Non-interactive Use 

 
l. "logpl" also has a non-interactive, or command mode, for automated 

processing. This is particularly useful for automatically generating plot of 
ancillary data for inspection at shift changes and after the experiment is over. 
To use "logpl" in command mode use the "-cmd" command line option: 
"logpl -cmd". You can start processing from a command file automatically 
by entering: "logpl -cfile xxx" where "xxx" is the name of the command file. 
You can even select the log file to process on the command line by entering 
"logpl -log lll -cfile xxx", where "lll" is the name of the log file. 
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KPGO VGOS BONN jive/m5copy (CentOS) 
 

***check webpage for transfer speed and port availability 
 
F1 Window (oper) 
Key on disk 
da-client 
group=mount:<slot> 
group=open:<slot> 
mstat?all 
Verify  

RAID “closed:unprotected:raid” 
SG “open:ready:sg” 

F2 Window (oper) 
cd /mnt/raid/ 
mkdir <experiment>_k2 
cd <experiment>_k2 
 
gator.py -t <slot> “<experiment>*.vdif” 
/mnt/raid/<experiment>_k2 
 
this will take a while… 30TB ~ 7 hours  
ls -1 | wc -l verify scans are there 
 
F1 Window (oper) 
group=close:<slot> 
group=unmount:<slot> 
Key off disk 
mstat?all 
quit 
 
F5 Window (oper) 
If jive is not running  
jive5ab-3.2.0-64bit-Debug 
 
F4 Window (oper) 
 
m5copy file:///mnt/raid/vo1123_k2/vo* 
file://89.1.14.226/data/vo1123/k2/ -udt -p 2633 -r 1200M –
resume; 
 
Note:  Correlator directory has to be setup and available for this to work.  
 
 
 



Westford VGOS Setup Checklist

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46

A B C
 Session Name _______________Correlator__________________Scans ____________ Date ____________
When used, carrots denote a variable.  Do not type the < > characters
so, <sched> becomes vo2027 <station id> becomes wf    Examples are in green.
Check hardware connections between RF distributor and UDC
Start in Login Shell window
fesh -d <sched>  Automatically gets files and creates session files
Drudg .skd file to generate snap summary for operational reference
If the schedule already exists on the FSPC, you will see an error saying it is there already
fsclient     This opens all operational windows to run session
Move to Operator Input Window
check_ntp            Verify the NTP is sync’d, one line has an asterisk
log=<sched><station id>    vo1201wf
rdbe_status                0x0941
mk6=dts_id?                  !dts_id?0:Mark6-5002:2.0.2-5:1.2;
Confirm MCI is running by viewing display and confirming clock is running, top right
mk6=msg?      0:NA; clears mark6 message queue
If needed erase module:
mk6=group=unprotect:<group>
mk6=group=erase:<group>
If needed initialize module: If not skip ahead to Create, Mount, and Open
mk6=mod_init=<slot>:<#disks>:<msn>:<type>:new    mk6=mod_init=1:8:HAY%0001:sg:new
Create, Mount, and Open the module for operations
mk6=group=new:<slots>     mk6=group=new:1     
mk6=group=mount:<slots>
mk6=group=open:<slots>
mk6=group?    Confirms if group is created properly      
Resume here if the module is already set up
mk6=mstat?1   Query for group 1  (can use 1,2,3,4,all)
time              This will display the RDBE pps,dot, and gps     
If there needs to be a time correction use the fmset  command  (more Info needed)
mk6in               Confirms RDBE data is streaming (2Gbps from each)
If needed to re-initialize the RDBE:
In a new shell window:
ssh oper@wfmark5-19
cd /srv/r2dbe_software/
./r2dbe_init_all  (can replace 'all' with either a,b,c,d)
wait for message saying completed successfully after X tries (time?)
Resume here if the R2DBE is already set up
Turn on antenna
Start pointing checks:
proc=point
initp
casa
proc=<schedule name><station id>    vo1201wf
setupbb
ifdbb
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47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86
87
88
89
90
91
92

A B C
mk6bb
rdbe=dbe_atten=
proc=point
onsource
fivept   Westford normal offsets less than .025 degrees xoffset     AZ_________EL________

SKIP onoff     Sefd numbers 2000-5000 are normal  (not working)(Show for Michael Lindqvist)
azeloff=0d,0d
Write a test scan on the Mark6
mk6=input_stream?
mk6=record=on:15:15:mk6tst:wf;
mk6=record? Do this command quickly while recording to show status
mk6=rtime?         Displays recording space left on disk
mk6=scan_check?
Cable cal check
cable       measures cable length delay
Insert piece of test cable inline with Type N cable in Mk3 IF3 module top of RF Rack
cablelong         measures long cable length  delay
Remove piece of test cable and reconnect original cable 
cable             Measures normal length cable delay
cablediff       difference between long and normal cable states, should be approx  (666 US)
In a separate window, only if requested:
Gator test scan on Mark6
DQA vdif files from test scan to confirm no problems
Resume here if no test scan needed:

SKIP start_mlog      This starts the multicast data (not working)
NEW Use Spectrum Analyzer to look at PCAL across Band……Should be about -100 dbm

Send Ready Message using the blue vgos-msg-gui window
Ctrl+Shift+m         Opens blue window for session messages 
Confirm Email address is in window is ' ivs-ops@lists.nasa.gov '
Or, In a new shell window:
rdbemsg
input weather, first source name and time, R2DBE information, dewar information
May be easier to start the schedule at this time, to get the first source information!
In the operator input Window:
schedule=<session><station id>,#<nnn>

LOOK Special VR sessions ONLY command
From the Mark6 login window
dboss s 1

LOOK On Pointing PC in lockable rack
Start Westford pointing program
Start recording encoder readings 1 second interval
Confirm session start and good first scan_check result
Send Start message using the Blue vgos-msg-gui window
Ctrl+Shift+m         Opens blue window for session messages 
Monitor session 
enter hourly WX  "weather : clear skies , and any operational comments in Operator Input
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93
94
95
96
97
98
99
100
101
102
103
104
105
106
107
108
109
110
111
112
113
114
115
116
117
118
119
120
121
122
123
124
125
126
127
128
129
130
131
132
133
134
135
136
137
138

A B C
End of Session:
schedule=

SKIP stop_mlog (not working)
LOOK Special VR sessions ONLY command

From the Mark6 login window
dboss s 4
Do pointing checks:
proc=point
casa
proc=<schedule name><station id>    vo1201wf
setupbb
ifdbb
mk6bb
rdbe=dbe_atten=
proc=point
fivept    Westford normal offsets less than .025 degrees xoffset    AZ_________EL________
onoff 
azeloff=0d,0d
Send Stop message with Blue vgos-msg-gui
Ctrl+Shift+m         Opens blue window for session messages 
Gator and Send tests scan to the correlator: (only if requested)
From the Mark6 terminal:
gator -t <slots> <scanname>.vdif ~/
Wait till the prompt reappears:  ~5 minutes
dqa  <scanname>.vdif
Confirm fill pattern is 0 and all threads are present
Send files to Haystack:
scp <scanname>_*.vdif oper@evlbi1.haystack.mit.edu:/data-st11/vgos/
Wait for confirmation from correlator that all data look good
Continue Here if no test scan needed. For Bonn/Hays:
Procedure to remove module for shipping:
mk6=group=close:<slots>
mk6=group=unmount:<slots>
Turn key OFF on disk module
mk6=mstat?all
Procedure for e-transfer (all other Correlators):
Leave module mounted and open
Insert RAID module in any other slot and follow e-transfer instructions
Transfer log session file
log=station
client=exit (this kills the local FS and closes all windows)
From Login Shell
plog –l         This is an “L”
cd ../log
drudg <sched> (drudg vo1201wf.log) (prints module label for shipping)
Stow Antenna 



Westford VGOS Setup Checklist

139
140
141

A B C
On Thumper 2: Xterm Umbrla window:    park  then press enter
Antenna should slew to AZ 180 El 45
Turn off antenna system


	Alex Burns TOW 2025 VGOS Setup.pdf
	1. Walking into your VGOS/VLBI site
	a. What do you see, hear, or smell?
	2. Experiment SNAP and procedure files
	3. Computer control
	4. Station timing
	5. Feed polarization
	6. Receiver
	7. RF distributor
	8. Antenna focus
	9. Antenna pointing
	10. System Equivalent Flux Density (SEFD)
	11.    System temperatures
	12.    Phase calibration signal
	13.    Cable calibration
	14.    Mark 6 Recording systems
	16.    Meteorological sensors
	17.    More extensive testing
	IVS Operations workshop TOW 2025
	6. Making comments in the log
	7. Periodic monitoring, I: each scan is correct:
	9. System failures
	10. Post experiment
	12. Running "logpl"

	Alex Burns Westford VGOS Checklist 09-15-2022.pdf
	Sheet1


